Building Accessible Documents

• Heading Styles
• Table of Contents
• Columns and Lists
• Extra Spaces & Tab Stops
• Paragraph Spacing
• Meaningful Link Text

• Images
• Captioning
• Tables
• Color Contrast
• Headers and Footers
• Accessibility Checker
What is Assistive Technology?

Assistive Technology (AT) are “products, equipment, and systems that enhance learning, working, and daily living for persons with disabilities.”

- Screen Readers
- Magnification Software
- Speech Recognition
- Trackball Mouse
- Keyboard
- Zoom Text
- Braille Computer Keyboard
- Captions/Subtitles
- Captioned Telephone
- Video Relay Services
Captioning Videos

Per federal and state law, and CSU policy, instructional media (e.g., videos, captured lectures, recorded presentations) must have captions. This includes instructional media used in classrooms, posted on websites or shared in Canvas.

- All students who are enrolled in a course must be able to access the content in the course.
- **Faculty:** Funding is available to help faculty generate captions and transcripts for instructional media. Materials should be submitted **at least six weeks** in advance of their use in instruction.
- **Staff:** For CSUN staff who do not provide classroom material, there is a cost through chargeback. For information on the chargeback, email [ncod@csun.edu](mailto:ncod@csun.edu).

[csun.edu/captioning](http://csun.edu/captioning)
What are Screen Readers

Screen readers are a form of assistive technology (AT) software that enables access to a computer, and all the things a computer does, by attempting to identify and interpret what is being displayed on the computer screen using text-to-speech. Screen readers can only access and process live text (fully editable or selectable text).

- Provides access to someone who is visually impaired, mobility or has a learning disability to access text on the screen.
- Offers same level of independence and privacy as anyone else.
Types of screen readers

Screen reader program for Microsoft Windows that allows blind and visually impaired users to read the screen either with a text-to-speech output or by a refreshable Braille display. **NVDA screen reader** can be **downloaded free of charge** by anyone.

Provides auditory descriptions of each onscreen element using gestures, a keyboard, or a braille display.

Adds spoken, audible, and vibration feedback to your device.

Screen magnifier for Microsoft Windows that allows you to see and hear everything on the computer.
How Do Screen Readers Work?

• Screen readers read line-by-line from left-to-right and top-to-bottom.

• Screen readers start at the top of a document or website and read any text including alternative text for images, graphics or charts.

• Screen readers navigate a document or website using the keyboard without a mouse. Tab key: jump from link to link, Enter: select a link, arrow keys: navigate a document or website.

• Reading order is important for users with visual challenges. The users can become confused if the document (content, tables, images or charts) is poorly organized or out of order.
Click vs Select

Screen readers and physical or mobility limitation users navigate a document or website using the keyboard without a mouse. The word “Click” is not inclusive of people who can’t use the mouse. Use the word “Select” to write step-by-step instructions.

“Click” or “Click on” Example

• Go to YouTube video player
• Click on Settings gear icon
• Click on Subtitles/CC
• Click on Options to Customize
• Click on Caption Style

Use “Select” Example (Recommend)

• Go to YouTube video player
• Select Settings gear icon
• Select Subtitles/CC
• Select Options to Customize
• Select Caption Style
Digital Accessibility Content Analogy

Organize content with headings, subheadings, images, videos, and footer are important for *usability* and *accessibility*. 
Microsoft Word 97 - 2003

If you encounter [Compatibility Mode] and unable to use Word Accessibility Checker, that’s because older version like Microsoft Word 97-2003 don’t have Accessibility Checker features available.

- **For Windows**: File tab, Info, Check for Issues
- **For Mac**: Review tab, Check Accessibility

Go to File Tab, select Convert Document, and OK. Word 2016 or Office 365 has Accessibility Checker features. Run Accessibility Checker again.

All CSUN faculty, staff, and students can install the Microsoft Office 365 on up to five personal devices for FREE.

- Faculty and staff [https://www.csun.edu/it/download-office](https://www.csun.edu/it/download-office)
- Students: [https://www.csun.edu/it/students](https://www.csun.edu/it/students)
• Divide large blocks of text into smaller sections
• Avoid overly complex sentences
• Provide adequate whitespace
• Use line or paragraph spacing (avoid Enter/Return for “blank” space)
• Avoid underlining text. Underlining is interpreted by screen readers and people with low vision as linked text.
• Font size between 12 – 18 point
• San-serif fonts are more suited to electronic formats (Arial, Calibri, Verdana or Franklin Gothic Book)
Direct vs Styles Formatting

Direct Formatting
• Not accessible to any assistive technology such as screen readers
• Can’t create a Table of Contents
• Can’t create a navigation to different sections in a document
• Huge barriers!

Styles Pane Formatting
• Provide structure and make document accessible
• Easier to modify existing formatting
• Create and update a Table of Contents
• Quicker navigation to different sections in a document
• Retain document structure when export to PDF
• Accessible to any assistive technology like screen readers
• Save time and save lives!
Example 1: Reading long, dense text documents can be a daunting task for learners.

As part of our commitment to excellence through diversity and inclusion, California State University, Northridge (CSUN) strives to ensure that campus communication and information technology is accessible to everyone. The California State University system statement on accessibility is articulated in California State University - Executive Order 1111, in accordance with both federal and state laws including the Americans with Disabilities Act of 1990 (ADA) and Section 508 of the U.S. Rehabilitation Act.

Need assistance or have a question not answered here? Please contact the Universal Design Center (UDC) at UDC@csun.edu or, during business hours (Monday through Friday, 8am to 5pm Pacific time), at (818) 677-5898.

In this context, “accessibility” means that people with disabilities have access - to facilities, to information and to technology.

“Universal design” takes this concept one step further, to ensure that everyone can perceive, understand, engage, navigate and interact regardless of ability or preference.

The UDC supports the campus community in their efforts to make it possible for individuals to learn, communicate, and share via information and communication technology. One way we do this is by assisting the campus community to ensure their information and communication technology is interoperable, usable and accessible, so that individual learning and processing styles and/or physical characteristics are not barriers to access.

The role of the UDC is to help CSUN implement business practices which enable the campus to meet policy standards under the Accessible Technology Initiative Coded Memoranda.

What does this mean to me?

Everyone has a part in creating accessible and usable information. The responsibility of creating and maintaining accessible content falls to the entire campus community.

Example 2: Well-structured documents help readers organize and process texts.

Universal Design Center

Accessibility Statement

As part of our commitment to excellence through diversity and inclusion, California State University, Northridge (CSUN) strives to ensure that campus communication and information technology is accessible to everyone. The California State University system statement on accessibility is articulated in California State University - Executive Order 1111, in accordance with both federal and state laws including the Americans with Disabilities Act of 1990 (ADA) and Section 508 of the U.S. Rehabilitation Act.

What is Accessibility? What is Universal Design?

In this context, “accessibility” means that people with disabilities have access to facilities, to information and to technology. “Universal design” takes this concept one step further, to ensure that everyone can perceive, understand, engage, navigate and interact regardless of ability or preference.

Universal Design Center Mission

The UDC supports the campus community in their efforts to make it possible for individuals to learn, communicate, and share via information and communication technology. One way we do
Heading Styles

- Heading Styles (Heading 1 through Heading 6) in a logical sequence. Do not skip heading levels i.e. Heading 2 to Heading 4, headings should be in order.
  - **Heading 1**: Document title or main content heading/title (just one)
  - **Heading 2**: Major section heading
  - **Heading 3**: Sub-section of the Heading 2
  - **Heading 4**: Sub-section of the Heading 3, and so on, ending with Heading 6
  - **Normal**: Text or Paragraph
  - **Title** in Word Style won't recognize when converting to a PDF. Start with **Heading 1** for the document title.

Headsings are styles to give a document structure by category or topic.

Without headings, a person using assistive technology like a screen reader cannot navigate by sections, subsections, or scan section titles to understand the document structure.
Heading Styles compatible with other programs

Microsoft Word

Website

\[ \text{\textless h1 \textgreater Main Heading \textless /h1} \]
\[ \text{\textless h2 \textgreater Sub Heading \textless /h2} \]
\[ \text{\textless h3 \textgreater Sub sub heading \textless /h3} \]
\[ \text{\textless h2 \textgreater Sub Heading \textless /h2} \]
\[ \text{\textless h3 \textgreater Sub sub heading \textless /h3} \]

Canvas

Header 2 -> This is the Title
Header 3 -> This is the sub title
Header 4 -> This is a category
Paragraph -> This is the body of the content

Google Docs

InDesign

Title
Subtitle
Heading 1
Heading 2
Heading 3
Heading 4
Heading 5
• Modify heading styles to match your preference
• Repeat for Heading 2 to 6

Modify Style
Apply Heading 1 to Document Title
Apply Heading 2 to all Section Title

Repeat for Heading 3 Sub-section Titles, etc.
Update [Style Name] to Match Selection

If you have text in your document that already has a style applied, you can change the formatting of that text and apply it to the style in the Styles Pane/Gallery.

1. Select text in your document that has direct formatting style, such as Heading 1. For example, change the point size for the Heading 1 style from 30 points to 24 points.

2. On the Home tab, in the Styles Pane group, select Heading 1 arrow down, select “Update to Match Selection.”

3. All text with the style that you changed will automatically change to match the new style that you selected.
OPTIONAL: Instead of plain heading styles, adding background color to spice up a new look. Be sure to check the color contrast is sufficient for those who have color deficiencies.

Select **Heading 2** background color using paint bucket icon then select **Update to Match Selection**.
Select **Heading 2** border line style, color and width then select **Update to Match Selection.**
How to show all Styles Pane in Word?

**Windows**

On the Home tab, select the *Styles* Dialog Box Launcher, and then select *Options*. Under *Select styles to show*, select *All styles*. All styles are displayed in the *Styles* task pane.

**Mac**

On the Home tab, select the *Styles Pane* box. Under *List*, select *All styles*.
The quickest way to check a document’s heading structure is to open the Navigation Pane

- View tab
- Select Navigation Pane
- Expanding the headings
<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 2</td>
<td>1</td>
</tr>
<tr>
<td>Heading 3</td>
<td>3</td>
</tr>
<tr>
<td>Heading 2</td>
<td>8</td>
</tr>
<tr>
<td>Heading 3</td>
<td>10</td>
</tr>
<tr>
<td>Heading 3</td>
<td>12</td>
</tr>
<tr>
<td>Heading 3</td>
<td>16</td>
</tr>
<tr>
<td>Heading 2</td>
<td>19</td>
</tr>
<tr>
<td>Heading 2</td>
<td>53</td>
</tr>
</tbody>
</table>

### Table of Contents

- **Introduction** .................................................. 1
- **What Is Less Doing?** ........................................... 3

**Fundamental 1: The 80/20 Rule** ................................ 8
- Tracking for Results ............................................. 10
- Optimizing your Processes and Creating the “Manual of You” ........................................ 12
- A Note on Essential vs. Optional ................................ 16
- 80/20 Advanced ..................................................... 18

**Fundamental 2: Creating an External Brain** ...................... 19
- Your External Brain ................................................ 21
- Setting up your External Brain ................................... 22
- Emptying your Inbox ............................................... 29
- Eliminating your To-Do List ...................................... 31
- Hiring a Virtual Assistant ........................................ 35
- Outsourcing Your Outsourcing ...................................... 43

**Fundamental 3: Customization** .................................. 47
- Where to start .................................................... 50

**Fundamental 4: Choose your own Workweek** .................... 53
Table of Contents

• Headings structure will automatically populate a table of contents and provide accessible for screen readers rely on headings structure to navigate a page quickly.

• Adding Table of Contents to any documents or syllabus over 8 pages to make it easier for readers to go directly to a specific section in the document.

• Or Custom Table of Contents
• To change which heading level appear on TOC, select ‘Options’
• Number each style in the order in the Table of Contents
• Select ‘Ok’ twice
Styles – Normal, Modify Style

Normal style for paragraph
Styles for formatting

**Bold** and *Italics* icons in the “Font” block are ignored by screen readers.

- Use **Strong** (instead of Bold) to indicate importance.
- Use **Emphasis** (instead of Italics) to indicate vocal stress.
- Avoid **underlining** text. Underlining is interpreted by screen readers and people with low vision as linked text.
  - Use **Strong** instead of underlining.

[Image of screen with text formatting options]
Lists

• Use the bulleted or numbered list formatting tool.

• Screen readers can read the number of items in a list before it begins to read the items.
Columns

• If you want to make columns, format them as columns. Screen readers can read the content organized in columns.

• Do not put text on one line and use several tab stops to move it over. Screen readers will read it one line a time, not as columns.

Optional: If you want to add line between the columns, select **More Columns**, checkbox **Line Between**.
Avoid Extra Spaces

• Screen readers will read blank or multiple spaces created using the space bar, empty line, empty tab, empty paragraphs or carriage returns as “Blank”.

• This can be very irritating for someone using assistive technology to listen multiple blank characters and may assume they’ve reached the end of a document.
Use Page Break

Screen readers can read blank characters as “Blank”. This can be very irritating, especially if there are multiple blank characters.

Word automatically adds a break at the end of each page. You can also insert a manual page break anytime you want to start a new page in your document.

• Put your cursor where you want one page to end and the next to begin
• Go to Insert > Page Break
Ruler Tab Marker

To create three columns in one line, set ruler tab marker as shown.

1. Select paragraph marks “Show/hide”
2. View tab then select Ruler
3. Remove extra white spaces, tabs, and spacebars (keep one tab only)
4. Highlight selected text
5. Set ruler tab marker position at 2” for second column and 4” for third column

Note: You can also set indentation in lieu of a single tab marker.
Paragraph or Line Spacing

- Avoid creating blank lines to create spaces between text.
- Use line or paragraph space to increase or decrease the amount of space between headings and paragraphs.
- Heading levels space between a heading and the previous section’s body text.

Universal Design Center (Heading 1)

Accessibility Statement (Heading 2)
As part of our commitment to excellence through diversity and inclusion, California State University, Northridge (CSUN) strives to ensure that campus communication and information technology is accessible to everyone. The California State University system statement on accessibility is articulated in California State University - Executive Order 1111, in accordance with both federal and state laws including the Americans with Disabilities Act of 1990 (ADA) and Section 508 of the U.S. Rehabilitation Act.

Need help? (Heading 3)
Need assistance or have a question not answered here? Please contact the Universal Design Center (UDC) at UDC@csun.edu or, during business hours (Monday through Friday, 8am to 5pm Pacific time), at (818) 677-5898.

What is Accessibility? What is Universal Design? (Heading 2)
In this context, “accessibility” means that people with disabilities have access – to facilities, to information and to technology. “Universal design” takes this concept one step further, to ensure that everyone can perceive, understand, engage, navigate and interact regardless of ability or preference.

Universal Design Center Mission (Heading 2)
The UDC supports the campus community in their efforts to make it possible for individuals to learn, communicate, and share via information and communication technology. One way we do this is by assisting the campus community to ensure their information and communication technology is interoperable, usable and accessible, so that individual learning and processing styles and/or physical characteristics are not barriers to access.

The role of the UDC is to help CSUN implement business practices which enable the campus to meet policy standards under the Accessible Technology Initiative Coded Memoranda.

Shared Campus Responsibility (Heading 3)
Everyone has a part in creating accessible and usable information. The responsibility of creating and maintaining accessible content falls to the entire campus community.
Paragraph Spacing

• On Styles Panel, select **Heading 2** and right-click to select **Modify**
• **Format** button to select **Paragraph...**
• **Heading 2** set Before: 12pt and After: 6pt.
• **Heading 3** set Before: 12pt and After: 6pt.
• **Normal** paragraph set Before: 0 pt and After: 18pt.

For example: If you increase spacing for Heading 2, it will increase spacing for the entire Heading 2.
You can control the vertical space between the lines of text in your document by setting the line spacing.

- Select one or more paragraphs to update line spacing
- Go to **Home** > Paragraph section
- Select **Line Spacing Options**
- Enter how much spacing before and/or after vertical space lines of text

---

**How many spaces BEFORE a paragraph?**

As part of our commitment to excellence through diversity and inclusion, California State University, Northridge (CSUN) strives to ensure that campus communication and information technology is accessible to everyone.

**How many spaces AFTER a paragraph?**
Screen readers can read blank characters as “Blank”. This can be very irritating, especially if there are multiple blank characters.
CSUN News

CSUN Honors Four Exceptional Graduate Students for Thesis and Project Work

CSUN’s Division of Academic Affairs has selected four exceptional CSUN graduate students as the winners of the 2020 Distinguished Thesis/Graduate Project Competition, with each receiving a $1,000 award and recognition from the university. Read more.

CSUN Team to Tap into Power of Inouye Telescope to Study Sun’s Atmosphere

With the aid of a telescope in Hawaii, a team of professors at California State University, Northridge hope to solve some of the mysteries found in the sun’s atmosphere, information that could help us better understand the impact of solar flares, as well as what is happening with other stars in our solar system. Read more.

Minimizing the COVID Slide During the Summer

In response to the COVID-19 pandemic, schools across the nation transitioned to meeting online. Given the abruptness of the transition and lack of preparation parents had in becoming in-home teachers’ aides, many parents and educators are worried about a “COVID slide” or “COVID slowdown,” where students fail to retain any new information learned before and during the pandemic — as well as over the summer, when students are not in school. Click here.

Screen readers read: "Read more, link" "Read more, link" "Click here, link"

CSUN News

CSUN Honors Four Exceptional Graduate Students for Thesis and Project Work

CSUN’s Division of Academic Affairs has selected four exceptional CSUN graduate students as the winners of the 2020 Distinguished Thesis/Graduate Project Competition, with each receiving a $1,000 award and recognition from the university. Learn more about CSUN’s Four Exceptional Graduate Students.

CSUN Team to Tap into Power of Inouye Telescope to Study Sun’s Atmosphere

With the aid of a telescope in Hawaii, a team of professors at California State University, Northridge hope to solve some of the mysteries found in the sun’s atmosphere, information that could help us better understand the impact of solar flares, as well as what is happening with other stars in our solar system. Continue reading about CSUN’s Astronomy Team.

Minimizing the COVID Slide During the Summer

In response to the COVID-19 pandemic, schools across the nation transitioned to meeting online. Given the abruptness of the transition and lack of preparation parents had in becoming in-home teachers’ aides, many parents and educators are worried about a “COVID slide” or “COVID slowdown,” where students fail to retain any new information learned before and during the pandemic — as well as over the summer, when students are not in school. Learn more about the "COVID Slide".

Screen readers read: The content and link text then announce the word "link"

Full URL text https://www.csun.edu/universal-design-center
(raw URL may not make sense to screen reader users or others, so make the link text descriptive i.e. Universal Design Center)
A presentation that is intended to be displayed electronically and in a printout, include the URL and a description in the link text. For example, “Universal Design Center (www.csun.edu/universal-design-center).”
Best Practices for Accessible Links

**DESCRIPTION**
- Link text must always properly describe the purpose of the link and tell a user where the link will take them.
- Do not use text such as “click here” or “read more,” nor web addresses (URLs).

**PRESENTATION**
- Each link on the page should be visually different from regular text on the website.
- Can be differentiated by color, bold, underline, or italics.
- Using color alone does not make it accessible.

**FUNCTIONALITY**
- Link functionality is about ensuring a link functions the way the user expects.
- Links must always enhance the accessibility of a webpage.
- Users must be able to access links using a mouse, keyboard, or speech recognition commands.

**LINKED IMAGES**
- A linked image is an image (with or without text) that is linked to another resource or webpage.
- Linked images need link descriptions as well as image descriptions (alt text).
- If the link description is different than the alt text, enter the link description in the HTML Title field.
- Visit [Linked Images](#) on the Best Practices for Accessible Images page for more information.
Visual Challenge

What’s the best way to make images accessible to everyone?
The purpose of **Alt Text** is to allow low vision or blind users who use text-to-speech assistive technologies (AT), such as screen readers, to understand the purpose of graphic images. Sighted users usually don’t see alt text unless they use AT.

- Screen readers and other AT *can’t* convert images into texts. So, when writing alt text, consider the following for images:
  - What is its purpose?
  - Is the image important enough to be there?
  - If there is no description, what will the screen reader users miss?
  - Be concise and eliminate unnecessary words.
  - When completing the alt text, use proper punctuation such as periods to indicate the end of the alt text. Without proper punctuation, some screen readers will run the alt text into the body text that follows and cause confusion to the user.

- “Image of…”, “Photo of…” is not needed because screen readers and other AT announce that it’s an “image” or “graphic”.

- There is no limit to the number of characters, but keep alt text descriptions short around 200 characters or less.

- Don’t insert hyperlinks in alt text because they are not clickable and can’t create descriptive link text.
A stair chase leading up to an entryway is painted yellow with bold black text that reads museums are now.

A hand reaches out of a computer screen giving the hand gesture for stop. The screen reads ‘access denied!’

On the left is the book cover for Haben The Deafblind Woman Who Conquered Harvard Law, and on the right is the quote: “In the Tigrinya language of Eritrea and Ethiopia, Haben means ‘pride.’”

Michelle Obama claps and Barack waves.

Student holds a diploma hardcover up in the air during CSUN commencement. Caption text "and together, as Matadors, we will move mountains."

More examples of How to Describe Images

- Document Learning Tools: Describing images
- How to Describe Images (Art, Chemistry, Diagrams, Flow Charts, Formatting & Layout, Graphs, Maps, Mathematics, Page Layout, Tables, Text-only images)
- Periodic Table of the Elements
- UDC Best Practices for Describing Images
Image Captions

• Captions are universal and accessible for everyone.

• Captions are read and visible to all users whether they use assistive technologies (AT) or not.

• Captions and alt text have different purposes.
  • **Captions** convey what’s visible in the image.
  • **Alt text** describes the visual aspect of the image and should be brief.

• If captions and alt text are similar in their descriptions, alt text can say “Photo caption below.” For example, see caption example as shown on the right side.

• **Don’t repeat** the image's caption as the alt text. People don't need to hear the same information twice.

**Caption Example**

**Caption:** People buying peanuts at the local farmer’s market.

**Alt Text:** Photo caption below. *(Indicate where image position above, below, left or right side.)*
What are Decorative Images?

- Conveys no information; does not provide meaningful information.
- Purely for visual effect.
- The horizontal line that divided the two sections.
- Line border image used as part of page design.
- Decorative images do not require a text alternative.
- **Decorative images, lines, borders, or shapes ignore by assistive technologies, such as screen readers.**

![Alt Text](image)

This line separator does not need alternative text because it does not convey any additional information.
Select the image, select **Picture Format** tab, then **Alt Text**.
Office 2016 – Adding Alt Text

Option 1: Mouse right-click **Format Picture**

Option 2: Select a picture, **Picture Format** tab, **Format Pane**, **Alt Text**
Image Position

Text wrapping around an image, screen readers will skip it. To ensure screen readers do not skip over an image, the image needs to be on its own line “In Line with Text”.

What is Accessibility? What is Universal Design? (Heading 2)

In this context, “accessibility” means that people with disabilities have access – to facilities, to information and to technology. “Universal design” takes this concept one step further, to ensure that everyone can perceive, understand, engage, navigate and interact regardless of ability or preference.

Universal Design Center Mission (Heading 2)

The UDC supports the campus community in their efforts to make it possible for all students, faculty, staff, visitors, and community partners to learn, communicate, and share via information and communication technologies. This is by assisting the campus community to ensure their information and technology is interoperable, usable and accessible, so that individual learning and processing styles and/or physical characteristics are not barriers to access.
Complex Images

Some images, such as graphs, charts or informative illustrations require fairly lengthy explanations to make them accessible. When this is the case, there are a few options:

1. Provide a brief alt text description of the image and a longer description within the text of the document. This may be helpful for others as well since some people have difficulty understanding charts and graphs.

2. Provide a brief alt text description of the image and create a section at the end of the document for long descriptions.

3. Provide a brief alt text description of the image and create a separate document with a long description of the image.

*Credit to* [Explore Access](https://www.exploreaccess.com)

---

**Example of Option 1**

Chart 1. Website Accessibility Assessment of All Organizational Charts. Findings from the assessment indicate the following: 5% of organizational websites had fewer than 2 errors on the home page; 20% had 3 to 5 errors; 45% had 6 to 10 errors; and 30% had more than 10 errors on the home page.
Art or SmartArt Shapes

Often shapes are used behind text to create emphasis. Most screen readers will not identify shapes, and you will often split up your text in awkward ways to make it fit within the shape.

The example below exemplifies what not to do (notice how the reading order is impacted when a shape is moved to the background in order for the text to show on top)

What not to do

Shapes rain on My parade.
Art or SmartArt Shapes Workaround

**Step 1:** Create stand-alone PowerPoint file for all Art Shapes (editable).

**Step 2:** Use SnagIt to capture Art Shapes (step 1) then copy an image into final slides (step 3)

**Step 3:** Create another PowerPoint file for final slides.

**Step 4:** Add Alt Text for an image (step 3)
Provide descriptions if using color to convey meaning

Example 1: Inaccessible color highlights in red

May 11-17, 2019

Example 1: Accessible with a description

May 11-17, 2019* (final exams)

Example 2: Inaccessible table

<table>
<thead>
<tr>
<th>Assignments (overdue in red)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td></td>
</tr>
<tr>
<td>Chapter 1</td>
<td></td>
</tr>
</tbody>
</table>

Example 2: Accessible table

<table>
<thead>
<tr>
<th>Assignments</th>
<th>Overdue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Yes</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>No</td>
</tr>
</tbody>
</table>

Example 3: Inaccessible color shape

Color identical may not be recognized by colorblind users

Example 3: Accessible color and number
People who have low vision or colorblind could encounter some difficulty distinguishing text color from a background color if the contrast is insufficient contrast ratio 1.5:1.

This example has a great color contrast ratio of 8.7:1. The contrast is sufficient for those who have color deficiencies

- Download Colour Contrast Analyser onto your computer (PC/Mac) to ensure accessible contrast or use an online contrast checker from WebAIM.
- WCAG Level AA requires a contrast ratio of at least 4.5:1 for regular sized text (12 or 14 pt. font) and 3:1 for large text (18 pt. font).
- Coblis Color Blindness Simulator
How to View Grayscale Document?

Image courtesy of Accessible Syllabus

- Information and charts should never be conveyed through color alone.
- Color may not be recognized by colorblind users.
- Provide text descriptions for charts and graphics.
- Charts & Accessibility by Penn State

To use color filters on **Windows:**
- Select **Start** > **Settings** > **Ease of Access** > **Color filters**.
- Switch on the toggle under **Turn on color filters**.

To use color filters on **Mac:**
- On your Mac, choose **Apple menu** > **System Preferences**, select **Accessibility**, select **Display**, select “Use grayscale”
Tips for Creating Accessible Tables

Use Word’s built-in to create Tables

- Create tables by inserting them. **Avoid creating tables by drawing boxes** and lines or by using tabs and spaces. Screen readers have difficulty understanding tables with odd cell sizes.
- Simple Data Tables only.
- Tables have a logical reading order from left to right, top to bottom.
- Tables are labeled with alternative text.
- Provide Title (i.e. Caption) and Summary before the Table.
- Use Table Tools editor to identify the different types of rows and columns such as Header Row and First Column.

Keep your table simple

- Simple tables are easier to interpret for all students and screen readers.
- **Avoid** merging cells, split cells, no blank cells, as well as tables nested within a cell.
- Use tables to organize data not format information. Never use table for layout.
- The complex a table (merging cells, nesting multiple headings under one, adding blank lines, etc.) the worse it will be for accessibility.
- Sample of [Simple Tables vs. Complex Tables](#) by Penn State.
# Accessible grading scale in table vs non-table format

## Non-table format

<table>
<thead>
<tr>
<th>Grade</th>
<th>Points</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>A plus</td>
<td>1000 to 970 points</td>
<td>96 to 100%</td>
</tr>
<tr>
<td>A</td>
<td>969 to 940 points</td>
<td>93 to 95%</td>
</tr>
<tr>
<td>A minus</td>
<td>939 to 900 points</td>
<td>90 to 92%</td>
</tr>
<tr>
<td>B plus</td>
<td>939 to 900 points</td>
<td>90 to 92%</td>
</tr>
<tr>
<td>B</td>
<td>899 to 870 points</td>
<td>86 to 89%</td>
</tr>
<tr>
<td>B minus</td>
<td>839 to 800 points</td>
<td>80 to 82%</td>
</tr>
<tr>
<td>C plus</td>
<td>799 to 770 points</td>
<td>76 to 79%</td>
</tr>
<tr>
<td>C</td>
<td>769 to 740 points</td>
<td>73 to 75%</td>
</tr>
<tr>
<td>C minus</td>
<td>739 to 700 points</td>
<td>70 to 72%</td>
</tr>
<tr>
<td>D plus</td>
<td>699 to 670 points</td>
<td>66 to 69%</td>
</tr>
<tr>
<td>D</td>
<td>669 to 640 points</td>
<td>63 to 65%</td>
</tr>
<tr>
<td>D minus</td>
<td>639 to 600 points</td>
<td>60 to 62%</td>
</tr>
<tr>
<td>F</td>
<td>599 points or lower</td>
<td>59% or lower</td>
</tr>
</tbody>
</table>

Different screen readers may read texts differently. The “+/−” may not be read out loud. Screen readers will read + symbol for plus but not - symbol. Screen readers do not know whether - symbol is minus, hyphen, dash, en dash or em dash. It is always a good practice to spell them out and spell out any abbreviations or make a reference to your abbreviation when used for the first time. Visit [Screen Readers: A Guide to Punctuation and Typographic Symbols](#).  

## Table format

<table>
<thead>
<tr>
<th>Grade</th>
<th>Points</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>A plus</td>
<td>960 to 1000</td>
<td>96 to 100%</td>
</tr>
<tr>
<td>A</td>
<td>930 to 959</td>
<td>93 to 95%</td>
</tr>
<tr>
<td>A minus</td>
<td>900 to 929</td>
<td>90 to 92%</td>
</tr>
<tr>
<td>B plus</td>
<td>860 to 899</td>
<td>86 to 89%</td>
</tr>
<tr>
<td>B</td>
<td>830 to 829</td>
<td>83 to 85%</td>
</tr>
<tr>
<td>B minus</td>
<td>800 to 829</td>
<td>80 to 82%</td>
</tr>
<tr>
<td>C plus</td>
<td>760 to 799</td>
<td>76 to 79%</td>
</tr>
<tr>
<td>C</td>
<td>730 to 759</td>
<td>73 to 75%</td>
</tr>
<tr>
<td>C minus</td>
<td>700 to 729</td>
<td>70 to 72%</td>
</tr>
<tr>
<td>D plus</td>
<td>660 to 699</td>
<td>66 to 69%</td>
</tr>
<tr>
<td>D</td>
<td>630 to 659</td>
<td>63 to 65%</td>
</tr>
<tr>
<td>D minus</td>
<td>600 to 629</td>
<td>60 to 62%</td>
</tr>
<tr>
<td>F</td>
<td>599 points or lower</td>
<td>59% or lower</td>
</tr>
</tbody>
</table>
Step 1: Insert - Table

- Use tables to organize data not format information
- Create table headings
- Include table captions or brief description
  - Select **Insert** tab, then select **Table**
  - Select the number of rows and columns by highlighting the boxes on the grid.
  - Type in the table data
Step 2: Select Table Header Row

A table header row contains column headings that provide context and aid navigation of the table. People who can’t see the table can have column headings read aloud.

Example of Header Row

Design Tab > Header Row

<table>
<thead>
<tr>
<th>Grade</th>
<th>Points</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>A plus</td>
<td>960 to 1000</td>
<td>96 to 100%</td>
</tr>
<tr>
<td>A</td>
<td>930 to 959</td>
<td>93 to 95%</td>
</tr>
<tr>
<td>A minus</td>
<td>900 to 929</td>
<td>90 to 92%</td>
</tr>
</tbody>
</table>

Example of Header Row and First Column

Design Tab > Header Row and First Column

<table>
<thead>
<tr>
<th>Name</th>
<th>Project</th>
<th>Presentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student 1</td>
<td>95%</td>
<td>100%</td>
</tr>
<tr>
<td>Student 2</td>
<td>90%</td>
<td>75%</td>
</tr>
<tr>
<td>Student 3</td>
<td>60%</td>
<td>85%</td>
</tr>
</tbody>
</table>
Step 3: Table Headers Properties

Proper **table headers** help readers understand how tables are organized into columns and rows. Avoid solely using text and cell formatting, such as making the text big or bold to mimic the visual appearance of a table header, as this provides no underlying information about the structure of the table.

**Table Properties Options: Row and Alt Text tabs**

- Deselect “Allow row to break across pages”
- Select “Repeat as header row at the top of each page”
- Enter alt text in Alt Text tab. If empty cells intentionally left blank to fill in answers, mention in Alt Text, Description box.

---

1. Highlight entire first row  
2. Right-click to select Table Properties
What is “Allow row to break across pages”? 

When inserting a table at the bottom of a page in Word, the table break across two pages show two repeating header rows. Users with visual or cognitive challenges or screen readers, breaking table content across two pages causes readability and comprehensive barriers. 

**Best practice accessibility is to keep table rows on the same page. See next slide.**
How to keep table rows on the same page?

1. Select the table which breaks across two pages then select **Layout** tab (under **Table Tools**) then **Properties**.

2. In **Table Properties**, select **Row** tab then uncheck **Allow row to break across pages** and check **Repeat as header row at the top of each page**, select then **OK** button.

3. Select the table rows, **Home** tab, select two arrows icon **Line Spacing Options**.

4. In the **Paragraph** settings, select **Line and Page Breaks** tab, check **Keep with next** option, then **OK** button. Now table rows are on the same page.
Step 4: Table – Insert Caption

Adding a caption or summary of your table is universal and accessible for everyone

- Select the table, then right click to select **Insert Caption** or
- Go to **References** tab, then select **Insert Caption**
- In the popup window, type the title of the table in the **Caption textbox**
- In the **Label textbox**, select **Table**
- **Position textbox**, select **Above selected item** then select **OK**

<table>
<thead>
<tr>
<th>Grade</th>
<th>Points</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>A plus</td>
<td>960 to 1000</td>
<td>96 to 100%</td>
</tr>
<tr>
<td>A</td>
<td>930 to 959</td>
<td>93 to 95%</td>
</tr>
<tr>
<td>A minus</td>
<td>900 to 929</td>
<td>90 to 92%</td>
</tr>
<tr>
<td>B plus</td>
<td>860 to 899</td>
<td>86 to 89%</td>
</tr>
<tr>
<td>B</td>
<td>830 to 829</td>
<td>83 to 85%</td>
</tr>
<tr>
<td>B minus</td>
<td>800 to 829</td>
<td>80 to 82%</td>
</tr>
<tr>
<td>C plus</td>
<td>750 to 799</td>
<td>76 to 79%</td>
</tr>
<tr>
<td>C</td>
<td>730 to 729</td>
<td>73 to 72%</td>
</tr>
<tr>
<td>C minus</td>
<td>700 to 729</td>
<td>70 to 72%</td>
</tr>
<tr>
<td>D plus</td>
<td>660 to 699</td>
<td>66 to 69%</td>
</tr>
<tr>
<td>D</td>
<td>630 to 659</td>
<td>63 to 65%</td>
</tr>
<tr>
<td>D minus</td>
<td>600 to 629</td>
<td>60 to 62%</td>
</tr>
<tr>
<td>E</td>
<td>599 points</td>
<td></td>
</tr>
</tbody>
</table>
Alternative way without using Table (no header row)

To create three columns in 1 line, set Tab Stops (see previous slide):

1. If Paragraph settings is not available, click on Quick Access Toolbar, More Command to select Paragraph settings.
2. View tab then select Ruler
3. Select text to create tabs
4. Open Paragraph dialog
5. In the lower left of the Paragraph dialog is the button for Tabs
6. Clear All existing Tab Stops for the selected text
7. Set new Tab Stops

Avoid multiple tabs key, space bar, and blank lines, someone with assistive technology like screen readers will listen excess spaces and lines.
Avoid using color as the only means to convey information. For example, in the table below, the complete and incomplete items may appear the same to someone who is color blind:

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project 1</td>
<td>March 15, 2020</td>
<td>X</td>
</tr>
<tr>
<td>Project 2</td>
<td>April 15, 2020</td>
<td>X</td>
</tr>
<tr>
<td>Project 3</td>
<td>May 15, 2020</td>
<td>X</td>
</tr>
</tbody>
</table>

A better option would be to provide another way of conveying information not just color alone:

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project 1</td>
<td>March 15, 2020</td>
<td>(N \text{ or } \text{No})</td>
</tr>
<tr>
<td>Project 2</td>
<td>April 15, 2020</td>
<td>(Y \text{ or } Yes)</td>
</tr>
<tr>
<td>Project 3</td>
<td>May 15, 2020</td>
<td>(Y \text{ or } Yes)</td>
</tr>
</tbody>
</table>
Q: Should I included headers and footers in my document?

A: Headers and Footers are not always read immediately to screen reader users. However, if a screen reader user wants to look at the header there are methods for them to do that.

Headers and Footers can be used to hold document information but should never hold important document content such as filename, document owner etc.
Headers and Footers, 2 of 2

- Insert tab
- Select Header or Footer
- Insert text or other document information
- Always include page numbers in the footer with the “Normal” style
The accessibility checker will identify certain accessibility issues:

- Headings that are not in logical order
- Images with no alt text
- Tables that have the header box checked
- Tables that have merged cells or with empty cells
- Large numbers of repeated blank characters (spacebars, tabs, enters)
Check for Issues, Check Accessibility

Always use Word’s built-in Accessibility Checker

Repair Errors, Warnings and Tips
What is a Document Title?

• A document title is a descriptive and meaningful version of the file name. When converting to PDF, titles are often visible in the PDF window or tab.

• When multiple PDFs are open, well defined PDF titles allow for easier distinction between them. This distinction is particularly useful when relying on screen readers.

• The best way to add a PDF title is to edit an original document such as Microsoft Office file. See next slide how to add a Document Title in Word Document.
How to add a Document Title?

1. Open Microsoft Word

2. Select **File** from the menu and select **Properties**

3. In the **Summary** tab, enter **Title** field to add a document title.

4. A title is a short descriptive sentence of what the document is about. For example, file name ‘**Accessible Tables.doc**’ versus the title ‘**Guide for Creating Accessible Tables**’.

5. Save the changes you made.
Converting a document to PDF

1. Select **File** from the menu and select **Save As**. Choose where you want to save the file.

2. In the **Save As** dialog box, choose **PDF** (Export Formats) in the File Format.

3. Select 1st radio button “**Best for electronic distribution and accessibility (Uses Microsoft online service)**”

4. Select **Export** button
Never choose a "Print" to PDF option in Office, or in any other program. A screen reader user may still be able to access the text of a PDF created in this way, but heading structure, alternative text, a logical reading order, and any other tag structure will be lost.

Use **Save As** choose PDF.
Open PDF files from Adobe Acrobat not Web Browser by default

• Save PDF files on Desktop
• Select PDF (not double click)
• File tab, Always Open with, Other
Adobe Creative Cloud for Faculty & Staff

- Adobe Creative Cloud software is now available for use (at no additional charge) on all faculty and staff university-owned computers, labs and classroom devices, and for all students.
- Please note that this deployment of Adobe software is not available for use on personally-owned faculty and staff devices at this time.
- Learn more about Adobe Creative Cloud for Faculty & Staff

- Adobe Acrobat DC

- Adobe Reader is for viewing, printing, signing, sharing, and annotating PDFs. Adobe Reader doesn’t have Accessibility checking tool.
Create with Accessibility in Mind

Best Practices

Document Accessibility

user-friendly document for CSUN student success

Alternative Text
- Images
- Shapes

Video/Audio
- Captions/transcripts

Navigation/Links
- Link requirements

Structure
- Headings
- Lists, etc.

Color
- Color contrast
- Meaning without color

User Interface
- Keyboard accessibility
How can we help you make a difference?

Universal Design Center Offers
- Online, self-paced training
- In-person training each semester
- Consultations
- Tools and Services

Universal Design means design for everyone